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Thank you for purchasing a P Series Pressure Gauge or PC Series Vacuum and Pressure Controller. 
Please take the time to find and read the information for your specific device. This manual covers the 
following Alicat Scientific instruments:
	 P Series Digital Pressure Gauges	
	 PC Series Vacuum and Pressure Controllers
	 PC3 Series Vacuum and Pressure Controllers
	 PCR Series High Flow Vacuum and Pressure Controllers 
	 PCR3 Series Vacuum and Pressure Controllers
	 PCD Series Dual Valve Pressure Controllers
	 PS, PCS, PCRS and PCDS Series instruments for use with aggressive gases (see page 42).
This includes P, PC and PCR Series devices labeled as approved for CSA Class 1 Div 2 and ATEX 
Class 1 Zone 2 hazardous environments. See pages 61 and 62 for Special Conditions regarding 
the use of CSA/ATEX labeled devices.
	 Alicat Portable Pressure Gauges
Note: All Alicat Portable Pressure Gauges operate in accordance with the P Series Pressure Gauge 
instructions found in this manual. Please see page 40 for information regarding battery replacement.
The P and PC Series data presentation format utilizes a full graphic display that allows viewing of all 
operating parameters. The installation (plumbing, mounting and power/signal connection instructions 
are applicable to all P, PC (includes PC3), PCR (includes PCR3) and PCD series devices. 
Unless specifically noted, all instructions for PC Series Controllers are applicable to PC3, PCR, 
PCR3 and PCD controllers as well.

Installation
Plumbing
All P Series Gauges and PC Series Controllers are equipped with female inlet and outlet port connections. 
No straight runs of pipe are required upstream or downstream of the gauge. The inlet and outlet ports are 
equal in size and symmetric (in-line). The port sizes (process connections) and mechanical dimensions 
for different pressure ranges are shown on pages 34 & 35. Pressure Gauges are shipped with a plug 
for static pressure measurement. This plug may be removed for flow through operation.
On all gauges/controllers, avoid the use of pipe dopes or sealants on the ports, as these compounds 
can cause permanent damage should they get into the flow stream. Use of thread sealing Teflon tape is 
recommended to prevent leakage around the threads. When applying the tape, avoid wrapping the first 
thread or two to minimize the possibility of getting a piece of shredded tape into the flow stream. When 
changing fittings, always clean any tape or debris from the port threads.
For additional notes on PCD (dual valve controller) plumbing see page 26.
For gas applications, it is recommended that a 50 micron filter be installed upstream of P and PCR 
Series instruments and a 20 micron filter be installed upstream of PC and PCD Series instruments. 
For liquid applications, see “Using P and PC Series Instruments with Fluids”, page 7.

For fittings and filters see page 53.
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Mounting
All P Series Gauges and PC Series Controllers have mounting holes for convenient mounting to flat 
panels. These meters are position insensitive and can be mounted in any orientation. The sizes and 
dimensions for the mounting holes are shown on pages 36 to 41.
P Series Pressure Gauges may be connected into your system with the flow going in either direction 
for ease of viewing the display. These units are shipped with a plug for dead end applications. This plug 
should be removed for flow through applications.
PC Series Vacuum and Pressure Controllers are normally intended to control the process pressure 
downstream of the controller. In order for this to occur the controller should be mounted so the flow 
goes from left to right as you look at the front of the unit. This puts the measuring portion of the device 
between the valve and the leakage point where you are attempting to control the pressure application. 
Back-pressure controllers reverse this configuration (see Fig. 15, page 23).
Using P and PC Series Instruments with Fluids
All of these devices may by used with chemically compatible liquids providing a couple of things are 
taken into account:

1.	 Water is about 50 times more viscous than air. This is important when sizing a pressure controller.  
The PC Series which can be used to flow up to 20 SLPM of gas, will be limited to roughly 0.5 
LPM of water-like fluid. The PCR will be limited to roughly 30 LPM of water-like fluid.

2.	 The factory PID tune is established using air flow. It may be necessary to adjust the PID tuning 
parameters if you will be using a controller with liquids.

Special Configurations
P, PC, and PCR Series pressure devices are occasionally ordered with special configurations which 
are covered here:

1.	 External Sense Port: Occasionally it is necessary or desirable to sense the pressure at some 
point other than at the location of the pressure device. All P, PC, or PCR Series pressure devices 
can be ordered with an additional NPT port which is connected directly with the pressure sensor 
of the device. In these devices the flow path through the device is NOT connected to the pressure 
sensor. See  “PC3 Series Pressure Controllers” – page 24.

2.	 Differential Pressure: Occasionally it is necessary or desirable to monitor or control a differential 
pressure. P, PC, and PCR Series pressure devices can be ordered as low differential pressure 
devices (usually 1 to 5 PSID). These devices have two ports located on the front face of the unit 
for connection to the points in the system where the differential pressure is to be measured. The 
upstream port is for the higher pressure and the downstream port is for the lower pressure. In 
these devices the flow path through the device is NOT connected to either leg of the differential 
pressure sensor. See “Differential Pressure Gauges and Differential Pressure Controllers” – 
page 25.
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Power and Signal Connections
Power can be supplied to your gauge or controller through either the AC/DC adapter jack (power jack 
not available on CSA/ATEX approved devices) or through the 8 pin Mini-DIN connector as shown in 
Figure 1.
A 2.1mm, positive center, 7-30 Vdc AC/DC adapter rated for at least 100 mA is required to use the 
adapter jack in a P Series pressure gauge.
A 2.1mm, positive center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is required to use the 
adapter jack in a PC or PCD Series pressure controller. Note: 4-20mA output requires at least 15 Vdc.
A 2.1mm, positive center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is required to use the 
adapter jack in a PCR Series pressure controller.
Cables can be purchased from the manufacturer (see Accessories on page 53) or they are available 
from electronics suppliers. Alternatively, power can be supplied through the Mini-DIN connector as 
shown below:

7 8

1 2

3 4 5

AC/DC Adapter Jack

6

1

3

2

4 5

6 7 8

Pin Function Mini-DIN cable color
1 Inactive or 4-20mA Primary Output Signal Black

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) 
                         or Basic Alarm Brown

3 RS-232 Input Signal Red

4 Analog Input Signal = Remote Tare (Gauges - see Figure 7)
                                = Set-Point In (Controllers - see Figure 2) Orange

5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communications and signals) Purple

Note: The above pin-out is applicable to all pressure gauges and controllers available with the Mini‑DIN 
connector. The availability of different output signals depends on the options ordered.
Underlined Items in the above table are optional configurations that are noted on the unit’s calibration sheet.

Figure 1. 8 Pin Mini-DIN Connector
CAUTION: Do not connect power to pins 1 through 6 as permanent damage can occur!

Note: Upon initial review of the pin out diagram in Figure 1, it is common to mistake Pin 2 (labeled 
5.12 Vdc Output) as the standard 0-5 Vdc analog output signal! In fact Pin 2 is normally a constant 
5.12 Vdc that reflects the system bus voltage and can be used as a source for the input signal. This 
allows the user in the field to run this output through a 50K ohm potentiometer and back into the analog 
set-point pin to create a 0-5 Vdc set-point source (see Figure 2).
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Input Signals
Analog Input Signal
Apply analog input to Pin 4 as shown in Figure 1.
Unless ordered otherwise, 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input signal 
to pin 4, with common ground on pin 8. The 5.12 Vdc output on pin 2 can be wired through a 50K ohm 
potentiometer and back to the analog input on pin 4 to create an adjustable 0-5 Vdc input signal source 
as in Figure 2 below.

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Figure 2. Simple Method for Providing Set-Point to Controllers
Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be applied to pin 4, with 
common ground on pin 8.
Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be applied to pin 4, with 
common ground on pin 8.  Note: This is a current sinking device.  The receiving circuit is essentially a 
250 ohm resistor to ground.  Do not attempt to connect it to “loop powered’” systems, as this will destroy 
portions of the circuitry and void the warranty.  If you must interface with existing loop powered systems, 
always use a signal isolator and a separate power supply. Note: 4-20mA output requires at least 15 Vdc 
power input.
RS-232 / RS‑485 Digital Input Signal
If you will be using the RS-232 or RS-485 input signal, it is necessary to connect the RS-232 / RS‑485 
Output Signal (Pin 5), the RS-232 / RS‑485 Input Signal (Pin 3), and Ground (Pin 8) to your computer 
serial port as shown in Figure 3. Adapter cables are available from the manufacturer or they can be 
constructed in the field with parts from an electronics supply house. In Figure 3, note that the diagrams 
represent the “port” side of the connections, i.e. the connector on top of the meter and the physical 
DB-9 serial port on the back of the computer. The cable ends will be mirror images of the diagram 
shown in Figure 3. (See page 22 for details on accessing RS-232 / RS‑485 input.)
Output Signals
RS-232 / RS-485 Digital Output Signal
If you will be using the RS-232 or RS-485 output signal, it is necessary to connect the RS-232 / RS‑485 
Output Signal (Pin 5), the RS-232 / RS‑485 Input Signal (Pin 3), and Ground (Pin 8) to your computer 
serial port as shown in Figure 2. Adapter cables are available from the manufacturer or they can be 
constructed in the field with parts from an electronics supply house. In Figure 2, note that the diagrams 
represent the “port” side of the connections, i.e. the connector on top of the meter and the physical 
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DB-9 serial port on the back of the computer. The cable ends will be mirror images of the diagram 
shown in Figure 2. (See page 27 for details on accessing RS-232 / RS‑485 output.)
Standard Voltage (0-5 Vdc) Output Signal
All P and PC Series pressure gauges/controllers have a 0-5 Vdc (optional 0-10 Vdc) output signal 
available on Pin 6. This is generally available in addition to other optionally ordered outputs. This 
voltage is usually in the range of 0.010 Vdc for zero pressure and 5.0 Vdc for full-scale pressure. The 
output voltage is linear over the entire range. Ground for this signal is common on Pin 8.
Optional 0-10 Vdc Output Signal
If your gauge/controller was ordered with a 0-10 Vdc output signal, it will be available on Pin 6. (See the 
Calibration Data Sheet that shipped with your gauge to determine which output signals were ordered.) 
This voltage is usually in the range of 0.010 Vdc for zero pressure and 10.0 Vdc for full-scale pressure. 
The output voltage is linear over the entire range. Ground for this signal is common on Pin 8.
Optional Current (4-20 mA) Output Signal
If your gauge/controller was ordered with a 4-20 mA current output signal, it will be available on Pin 1. 
(See the Calibration Data Sheet that shipped with your device to determine which output signals were 
ordered.) The current signal is 4 mA at 0 pressure and 20 mA at the gauge’s full scale pressure. The 
output current is linear over the entire range. Ground for this signal is common on Pin 8. (Current output 
units require 15-30Vdc power.)
Note: This is a current sourcing device. Do not attempt to connect it to “loop powered” systems. If you must 
interface with existing loop powered systems, always use a signal isolator and a separate power supply.
Optional 2nd Analog Output Signal
You may specify an optional 2nd analog output on Pin 2 at time of order. (See the Calibration Data 
Sheet that shipped with your device to determine which output signals were ordered.) This output may 
be a 0-5 Vdc, 0-10 Vdc, or 4-20 mA analog signal that can represent any measured parameter. 
Note: This is a current sourcing device. Do not attempt to connect it to “loop powered” systems. If you must 
interface with existing loop powered systems, always use a signal isolator and a separate power supply.

7

4

6

21

DB-9 Serial Port

5

5----------Ground--------------------------------------Ground----------8
3----------Transmit------------------------------------Receive---------3
2----------Receive-------------------------------------Transmit--------5

8 Pin Mini-DIN Port

8

1 2 3 4 5

6 7 8 9
3

 

4 5
6 7 8

2

Figure 3. Mini-DIN to DB-9 Connection for RS-232 / RS-485 Signals
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5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow

Figure 4. Typical Multiple Device (Addressable) Wiring Confi guration
Note: The easiest way to connect multiple devices is with a Multi-Drop Box (see page 51).

An industrial connector is standard on all CSA/ATEX approved devices (see pages 61 & 62). It is also 
available as an option on all other Alicat instruments.

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 - White
4 Analog Input Signal Green
5 Ground (common for power,

                     communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

Figure 5. Optional Industrial Connector
Note: The above pin-out is applicable to all the pressure gauges and controllers ordered with the 
industrial connector. The availability of different output signals depends on the options ordered.
DB15 Pin-out Diagrams: Pin-out diagrams for devices ordered with a DB15 connector can be found 
on pages 56 to 60.
PROFIBUS Pin-out Diagrams: Pin-out diagrams for PROFIBUS confi gured devices can be found on 
pages 47 and 55.
DeviceNet Information and Pin-out Diagram:
Pin-out and operating information for DeviceNet confi gured devices can be found on page 50.
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P Series Gas Pressure Gauge Operation
The P Series can have several screen “modes” depending on how the device is ordered. All P Series 
Gauges have a default Main Mode, Select Menu Mode, a Communication Select Mode, a Manufacturer 
Data Mode and a Miscellaneous Mode. The device defaults to Main Mode as soon as power is applied 
to the gauge.
Note: P Series Pressure Gauges may also be ordered as portable devices as described on page 50.
Main Mode
The main mode screen shows the pressure in the units specified at time of order.

Main

Tare

Press
PSIG

PSIA
+0.00

+   .

Figure 6. Main Mode Display, P Series Pressure Gauge
The “MODE” button in the lower right hand corner toggles the display between modes.
Tare – P Series gauges which reference atmospheric pressure as zero (gauge pressure devices) have 
a tare button. Pushing the dynamically labeled Tare button in the upper right hand corner tares the 
pressure gauge and provides it with a reference point for zero pressure. 
This is a very simple but important step in obtaining accurate measurements. It is good practice to 
“zero” the gauge any time the gauge does not read zero when exposed to atmospheric pressure. 
If the unit reads a significant negative value when it is exposed to atmospheric pressure, it is a good 
indication that it was given a false tare.
Note: A remote tare can be achieved by momentarily grounding pin 4 to tare as shown in Figure 7 on 
page 13.
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Figure 7. Proper Set Up for Remote Tare on Gauges (Momentarily ground Pin 4 to Tare)

Flashing Error Message: Our pressure gauges and controllers display an error message (POV = 
pressure overrange) when a the pressure exceeds the range of the sensors in the device. When any 
item flashes on the display, the pressure measurement is not accurate. Reducing the pressure to within 
specified limits will return the unit to normal operation and accuracy.

Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display. Push the button nearest your selection to 
go to the corresponding screen. Push “Mode” again to return to the Main Mode display. 

Comm.
RS232F

Mfg.
Data Menu

Misc

SELECT
MENU

Figure 8. Select Menu Display
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Communication Select Mode
The Communication Select mode is accessed by pressing the button below “Comm. RS-232” or “Comm. 
RS-485” on the Select Menu display. The screen will appear as shown in Figure 9 below.

UP DOWN

Comm.

RS232F

Main

>

UnitID   ( A ) . . . . .     A

Baud   ( 19200 ) . . .   19200

Data  Rate. . . . . .     Fast

Select

Figure 9. Communication Select Display
Unit ID – Valid unit identifiers are letters A-Z and @ (see Note below). This identifier allows the user to 
assign a unique address to each device so that multiple units can be connected to a single RS-232 or 
RS-485 port on a computer. The Communication Select Mode allows you to view and/or change a unit’s 
unique address. To change the unit ID address, press the “Select” button in the upper left corner of the 
display until the cursor arrow is in front of the word “Unit ID”. Then, using the UP and DOWN buttons at 
the bottom of the display, change the unit ID to the desired letter. Any ID change will take effect when 
the Communication Select Screen is exited by pushing the MODE button.
Note: When the symbol @ is selected as the unit ID, the device will go into streaming mode when the 
Communication Select Mode is exited by pushing the MODE button. See the RS-232 Communications 
chapter in this manual for information about the streaming mode. Note: RS‑485 units do not have a 
streaming mode.
Baud – The baud rate (bits per second) determines the rate at which data is passed back and forth 
between the instrument and the computer. Both devices must send/receive at the same baud rate in 
order for the devices to communicate via RS-232 or RS-485. The default baud rate for these devices 
is 19200 baud, sometimes referred to as 19.2K baud. To change the baud rate in the Communication 
Select Mode, press the “Select” button in the upper left corner of the display until the cursor arrow is 
in front of the word “Baud”. Then, using the UP and DOWN buttons at the bottom of the display, select 
the required baud rate to match your computer or PLC. The choices are 38400, 19200, 9600, or 2400 
baud. Any baud rate change will not take effect until power to the unit is cycled.
Data Rate – Changing the Data Rate affects the rate at which the instrument dumps its data. Slow 
mode inserts idle characters between the data characters. The speed of the Fast rate is determined by 
the selected baud rate. It is sometimes desirable to reduce the data rate if the communication speed 
bogs down the computer’s processor (as is not uncommon in older laptops), or to reduce the size 
of data files collected in the streaming mode. To change the data rate in the Communication Select 
Mode, press the “Select” button in the upper left corner of the display until the cursor arrow is in front 
of the word “Data Rate”. Then, using the UP and DOWN buttons at the bottom of the display, select 
either Fast or Slow. Any data rate change will be effective immediately upon changing the value 
between Fast and Slow.
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Manufacturer Data Mode
“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display (Figure 
8). The “Mfg 1” display shows the name and telephone number of the manufacturer. The “Mfg 2” display 
shows important information about your pressure device including the model number, serial number, 
and date of manufacture. 

Mfg1

Main

A l i c a t  S c i e n t i f i c   I n c .

Ph 520-290-6060

Fax 520-290-0109

Mfg2

Main

Mdl  P-1PSIG-D

Serial  No.   47117

Date  Mfg.    11/07/2010

Calibrated   By   DL

Software   GP07R23	

Figure 10. Manufacturer Data Displays
Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 11. Push the 
button above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and 
“DOWN” buttons to make the adjustment.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.
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UP DOWN Misc

Main

>

LCD   Contrast ( 10 )  . .      10

PVM   DBand (0.5% FS)  .      0.5

PRESS   Avg (001) . . . .        001

FLOW   Avg (001) . . . . .        001

Select

Figure 11. Miscellaneous Display
LCD Contrast: The Liquid Crystal Display Contrast can be adjusted between 0 and 30 with zero being 
the lightest contrast and 30 being the darkest contrast. To change the contrast, press the “Select” 
button in the upper left hand corner of the display until the cursor arrow is in front of the words “LCD 
Contrast (X)”. Then using the UP and DOWN buttons at the bottom of the display, change the contrast 
value as desired. The change is immediate and the effect can be monitored as the value is changed.
Display Zero Deadband: Zero deadband refers to a value below which the display simply jumps to 
zero. This deadband is often desired to prevent electrical noise from showing up on the display as minor 
flows or pressures that do not actually exist, especially in high noise (electrical) environments. This 
display deadband does not affect the analog or digital signal outputs — there is no zero deadband on the 
output signals. The display zero deadband can be adjusted between 0 and 3.2% of the Full Scale (FS) 
of the sensor. PVM refers to Pressure, Volumetric Flow, and Mass Flow, the three parameters to which 
the deadband applies. Note: Only the Pressure parameter is applicable to and adjustable in pressure 
devices. To adjust the display zero deadband, press the “Select” button in the upper left hand corner of 
the display until the cursor arrow is in front of the words “PVM DBand (X %F.S.)”. Then using the UP 
and DOWN buttons at the bottom of the display, change the display zero deadband value as desired.
Pressure Averaging: It is sometimes advantageous to apply an averaging factor to the pressure output 
(and display) to make it easier to read and interpret rapidly fluctuating pressures. Pressure averaging 
can be adjusted between 1 (no averaging) and 256 (maximum averaging). This is a geometric running 
average where the number between 1 and 256 can be considered very roughly equivalent to the 
response time constant in milliseconds. This can be very effective at “smoothing” high frequency process 
oscillations such as those caused by diaphragm pumps. To adjust the pressure averaging, press the 
“Select” button in the upper left hand corner of the display until the cursor arrow is in front of the words 
“PRESS Avg (XXX)”. Then using the UP and DOWN buttons at the bottom of the display, change the 
pressure averaging value as desired.
Flow Averaging: While “FLOW Avg” appears on the display, this adjustment has no application in 
pressure devices. Changing it will have no effect on the operation of a pressure device. 
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Information for Alicat TFT (Color Display) Gauges
Alicat TFT (color display) instruments have a hi-contrast back-lit LCD display. TFT instruments operate 
in accordance with Alicat standard operating instructions with a few notable differences. 
Multi-Color Display 
The color of each parameter is displayed on the Main Mode screen as follows:
		  GREEN = NORMAL CONDITIONS
		  YELLOW = OVER 100% - 128%
		  RED = OVER 128% 
Each parameter (mass flow, volumetric flow, pressure, temperature) will independently show its 
operating condition according to the above colors. If the parameter is selected, the main (large) number 
will display in the same color.
Main Mode: Operation equal to Main Mode on the standard monochrome display.
Select Sub-Menu Mode: Operation equal to Select Menu Mode on the standard monochrome display.
Gas Select Mode: Operation equal to Gas Select Mode on the standard monochrome display.
Manufacturer Data Mode: Operation equal to Manufacturer Data Mode on the standard monochrome 
display.
Miscellaneous Mode: Operation equal to Miscellaneous Mode on the standard monochrome display.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers
The following specifications are applicable to Alicat TFT (color display) meters, gauges and controllers 
only. All other operating specifications are shown in the Technical Data page for standard Alicat 
instruments. All standard device features and functions are available and operate in accordance with 
the Alicat operating manual provided with the device. 

Specification Meter  or Gauge Small Valve Controller Large Valve Controller
Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 24Vdc

Note: Alicat recommends the use of non-rechargeable 9 Vdc lithium batteries in all MB TFT (color 
display portable) meters. 
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PC, PC3, PCR3, PCR and PCD Series Pressure Controller Operation
All PC, PC3, PCR3, PCR and PCD Series Controllers have a default Main Mode, a Select Menu Mode, 
a Control Setup Mode, a Communication Select Mode, a Manufacturer Data Mode and a Miscellaneous 
Mode. The device defaults to Main Mode as soon as power is applied to the controller.
PC Series Pressure Controllers are normally shipped with a 0.050” diameter valve orifice which permits 
flows up to 20 SLPM (with inlet pressure 20 PSI over controlled pressure). For much smaller flows, 
consult factory for details on specifying a smaller valve orifice. For larger flows, a PCR Series Pressure 
Controller is recommended. For additional information specific to the PCD series (dual valve 
controllers) see page 26.
Main Mode
The main mode screen shows the pressure in the units specified at time of order.

Main

Set Pt.
0.000  

Press
PSIG

PSIG
+0.00

+   .

Figure 12. Main Mode Display, PC Series Pressure Controller
The “MODE” button in the lower right hand corner toggles the display between the Main Display and 
the Select Menu Display.
Line Pressure – Pressing the dynamically labeled PSIG button located in the upper left corner of the 
display will move the line gauge pressure to the primary display.
Set Pt – The set-point is shown in the upper right corner of the display. The set-point cannot be adjusted 
from the main mode screen. (For information on changing the set-point, see “Control Set Up Mode”.)
Flashing Error Message: Our pressure gauges and controllers display an error message (POV = 
pressure overrange) when the pressure exceeds the range of the sensors in the device. When the 
pressure reading flashes on the display, the pressure measurement is not accurate. Reducing the value 
of the line pressure to within specified limits will return the unit to normal operation.
Select Menu Mode
Pushing “Mode” once will bring up the “Select Menu” display (Figure 13, page 18). Push the button 
nearest your selection to go to the corresponding screen. Push “Mode” again to return to the Main 
Mode display.
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Control
Setup

Comm.
RS232F

Mfg.
Data Menu

Misc

SELECT
MENU

Figure 13. PC Series Select Menu Display
Control Setup Mode
The Control Setup Mode is accessed by pressing the center button above “Control Setup” on the select 
menu display. This mode allows the user to set up most parameters commonly associated with PID 
control. PC Series Pressure Controllers allow the user to select how the set-point is to be conveyed to 
the controller, what that set-point is if control is local, and what the Proportional and Differential terms 
of the PID control loop will be. The UP and DOWN buttons for adjusting variables can be held down for 
higher speed adjustment or pressed repeatedly for fine adjustment. 

Loop

UP DOWN

Control

Setup

InputSelect

>
P    98     >Mass  	 Analog
D  5002    Volume         >Serial
AUTOoff  Press          Local
Set   0.000

Figure 14. PC Series Control Setup Display
Input – PC Series Pressure Controllers normally ship defaulted to analog control as indicated in Figure 
14 above. To change how the set-point will be conveyed to the controller push the button in the upper 
right hand corner just above the dynamic label “Input” until the arrow is directly in front of the desired 
option. The controller will ignore any set-point except that of the selected input and it will remember 
which input is selected even if the power is disconnected.
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Analog refers to a remote analog set-point applied to Pin 4 of the Mini-DIN connector as described 
in the installation section of this manual. To determine what type of analog set-point your controller 
was ordered with, refer to the Calibration Data Sheet that was included with your controller. 0-5 Vdc is 
standard unless ordered otherwise. Note that if nothing is connected to Pin 4, and the controller is set 
for analog control, the set-point will float at some positive value.
Serial refers to a remote digital RS-232 / RS-485 set-point applied via a serial connection to a computer 
or PLC as described in the Installation and RS-232 / RS-485 sections of this manual.
Local refers to a set-point applied directly at the controller. For more information on changing the set 
-point locally refer to the heading “Select” below. Local input must be selected prior to attempting to 
change the set-point locally.
Loop –  The PC Series is defaulted to pressure.
Select – To avoid accidental changing of the PID loop parameters or the set-point, the Control Setup 
mode defaults with the selector on a null position. To change the set-point or the P and D PID loop 
parameters, push the button in the upper left corner just above the dynamic label “Select” until the 
selection arrow is pointing to the parameter you wish to change. When the parameter you wish to 
change is selected, it may be adjusted up or down with the buttons under the display below the dynamic 
labels “UP” and “DOWN”. Press the buttons repeatedly to make slow adjustments or hold them down 
to make fast adjustments.
P refers to the Proportional term of the PID loop. Before changing this parameter, it is good practice to 
write down the initial value so that it can be returned to the factory settings if necessary.
D refers to the Differential term of the PID loop. Before changing this parameter, it is good practice to 
write down the initial value so that it can be returned to the factory settings if necessary.
Set refers to the Set-point. This parameter may only be changed if “Local” is selected as the Input. See 
above for information on selecting the input. Using the UP and DOWN buttons, the set-point may be 
adjusted between zero and the full-scale range of the controller. CAUTION! Never leave a Controller 
with any non-zero set-point if no flow is available to make pressure. The controller will apply full 
power to the valve in an attempt to reach the set-point. When there is no flow, this can make the valve 
very HOT!

Communication Select Mode
The Communication Select mode is accessed by pressing the button below “Comm. RS-232” 
or “Comm. RS-485” on the Select Menu display. Please see page 14 for Communication Select 
mode instructions.

Manufacturer Data Mode
“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display 
(Figure 12, page 17). The “Mfg 1” display shows the name and telephone number of the manufacturer. 
The “Mfg 2” display shows important information about your pressure gauge including the model 
number, serial number, and date of manufacture (Figure 10, page 15).

Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 11. Push the 
button above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and 
“DOWN” buttons to make the adjustment. See pages 15 & 16.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.
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Information for Alicat TFT (Color Display) Controllers
Alicat TFT (color display) instruments have a hi-contrast back-lit LCD display. TFT instruments operate 
in accordance with Alicat standard operating instructions with a few notable differences. 
Multi-Color Display 
The color of each parameter is displayed on the Main Mode screen as follows:
		  GREEN = NORMAL CONDITIONS
		  YELLOW = OVER 100% - 128%
		  RED = OVER 128% 
Each parameter (mass flow, volumetric flow, pressure, temperature) will independently show its 
operating condition according to the above colors. If the parameter is selected, the main (large) number 
will display in the same color.
Main Mode: Operation equal to Main Mode on the standard monochrome display.
Select Sub-Menu Mode: Operation equal to Select Menu Mode on the standard monochrome display.
Gas Select Mode: Operation equal to Gas Select Mode on the standard monochrome display.
Manufacturer Data Mode: Operation equal to Manufacturer Data Mode on the standard monochrome 
display.
Miscellaneous Mode: Operation equal to Miscellaneous Mode on the standard monochrome display.
Control Setup Mode Controllers Only: Operation differs from Control Setup Mode on the standard 
monochrome display in that two screens are used.
Setup 1 allows you to set up most parameters commonly associated with input/se-point control: Input - 
Analog serial or local; Loop - Mass, Pressure or Volume; and Set-point control addition to the parameters 
explained in the Control Setup Mode section of the manual (page 13). 
The TFT Control Setup1 display also shows: 
Set — with the number inside the parenthesis being the set-point that is saved in the unit’s memory. 
This number is the last set-point given before exiting the control setup screen. The number on its right 
signifies the current set-point in real time. The set-point will change in real time as adjusted but it will 
not be saved into memory until you exit the control Setup1 and Setup2 screens.
 (FS=XX.XX) — The number equaling FS  is the full scale flow rate of the unit and 0.0% is the percentage 
of the set-point from 0-100%. So, for an example using (FS=160)SLPM, if you adjust the set-point to 
80.00 on the “Set” line you will simultaneously see the percentage change to 50% as 80 is half of 160.
Pressing the button under “Setup1” will switch the display to “Setup2”.
Setup 2 displays: Control Algorithm Type (PDF or PD2I) and the values for the Proportional, Differential 
and Integral terms; and Autotare On or Off.
The PDF algorithm is the standard PID algorithm used on most controllers. This is explained on 
page 13 of this manual.
The PD2I algorithm is used primarily for high performance pressure and flow control applications.  
When this algorithm is selected via control Setup2, the ‘I’ gain value is forced to a numerically ‘odd’ 
value (ending in 1, 3, 5, 7, or 9). This algorithm exhibits two basic differences from the standard PID 
algorithm that most controllers utilize.
1. Instead of applying a damping function based upon the rate of change of the process value, it applies 
a damping function based upon the square of the rate of change of the process value.
2. The damping function is applied directly to the proportional error term before that term is used in 
the proportional and integral functions of the algorithm. This provides a certain amount of ‘look ahead’ 
capability in the control loop.
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Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations in pressure controllers.  
You will know that ‘P’ gain is too high, when the controller breaks into fast oscillations on step changes 
in set-point. On flow controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’ gain 
results in overshoot and/or slow oscillation. A good starting value for ‘P’ gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the ‘D’ gain value should be left 
at or near the factory setting because it relates primarily to the system phase lags. If you are changing 
from the default algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges to the set-point, after the initial 
step change. Too low a value for ‘I’ gain shows up as a process value that jumps to near the set-point 
and then takes awhile to converge the rest of the way. Too high a value for ‘I’ gain results in oscillation.  
A good starting value for the ‘I’ gain is 201.
Caution: Valve tuning can be very complex. If you would like assistance, please contact Alicat for 
technical support.
AUTO: Autotare is a function that automatically tares the controller when a zero set-point is given. 
Control Setup2 shows a line marked “AUTO”. In parenthesis you see ON or OFF to signify the current 
setting. 
With AUTO set to OFF the controller will not tare when a zero set-point is given and conversely the 
controller will automatically tare if the function is set to ON. As with the set-point, you must exit the 
control Setup1 and Setup2 screens to save the setting to the unit’s memory. 
Control Setup1 and Control Setup2 displays are shown below.

Loop

Up Down Setup1

MainInput

Analog	         Mass
S e r i a l 	     V o l u m e
Local	                        Pressure

Set   (  0.00) .  .  	             0.00
(FS=  160.00)                             0.0%

Setup1

PD2I PDF Setup2

MainSelect

Type    ( PD2I ) . . . . .   P D 2 I
P r o  ( 100 ) . . . . .  200
Dif  ( 65535 ) . . . . .    20
I n t  ( 65535 ) . . . . .    201
AUT0   ( On )                                     Off

TFT Control Setup1 TFT Control Setup2

Technical Data for TFT (Color Display) Meters, Gauges and Controllers
The following specifications are applicable to Alicat TFT (color display) meters, gauges and controllers 
only. All other operating specifications are shown in the Technical Data page for standard Alicat 
instruments. All standard device features and functions are available and operate in accordance with 
the Alicat operating manual provided with the device. 

Specification Meter  or Gauge Small Valve Controller Large Valve Controller
Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 24Vdc
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Alicat Precision 
Pressure Controller

Pressure Control Application, Upstream Valve

Back Pressure Control Application, Downstream Valve (DS)
Specify DS in part number adder code
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Pressure 
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Pressure Controller
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Process
Flow Exiting
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Figure 15. Upstream and Downstream Valve Diagram
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PC3 and PCR3 Series Pressure Controllers:
The PC3 and PCR3 Series pressure controller is designed to change the flow to allow the control of 
pressure at some point away from the body of the controller. 
This is most helpful when it is necessary to mount pneumatic components such as valves, fittings or 
flow meters that introduce significant pressure drop between pressure controller body and the point 
where pressure control is necessary. 
To accomplish this, the PC3 has an external sensing port to which the pressure at the location where 
pressure is to be controlled is piped back to the pressure sensor in the controller.

P1

P3

P3 P3 P3

P3

P3P2

Nozzle Under Test

Flow Meter (Pressure Drop)PC3 Series Pressure ControllerPC3 Series Pressure Controller	         Flow Meter (Pressure Drop)

Nozzle Under Test

Figure 16. Typical PC3 Application Diagram

P1 P2

P3 P3

P3
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Differential Pressure Gauges:
The differential pressure gauge is designed to measure a pressure ratio between two points in the line. 
There are a variety of applications for this device. One of the most common is to measure the difference 
in pressure across some sort of element that changes resistance to flow over time, such as a filter, or 
one that changes area with time as would happen with orifice testing. The gauge has two sensing ports 
which are piped to the upstream and downstream sides of the pressure drop of interest in the system. 
These two ports run either to two separate pressure sensors or for low differential pressures – they may 
be run to the two legs of a single differential pressure sensor. The higher (upstream) pressure is applied 
to the left port and the lower (downstream) pressure is applied to the right port.

P2P1

P2P1

Figure 17. Differential Pressure Gauge 
Differential Pressure Controllers:
The differential pressure controller is designed to change the flow to allow the control of a pressure 
ratio between two points in the line. There are a variety of applications for this device. One of the most 
common is to control the difference in pressure across some sort of element that changes resistance to 
flow over time, such as a filter or one that changes area with time as would happen with orifice testing. 
To accomplish differential pressure control, the controller has two sensing ports which are piped to the 
upstream and downstream sides of the pressure drop in the system. These two ports run either to two 
separate pressure sensors or for low differential pressures – they may be run to the two legs of a single 
differential pressure sensor. The controller itself changes the flow to the two sensing ports until the 
difference between the two pressures matches the set-point.

P2P1

P2P1

Figure 18. Differential Pressure Controller 

P1 P2

P1 P2
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PCD Series Dual Valve Pressure Controller Operation
PCD Series Closed Volume Pressure Controllers
Alicat Scientific PCD Series Closed Volume Pressure Controllers incorporate a digital pressure gauge 
with dual control valves and circuitry. The integrated PID loop measures the pressure, compares it with 
the set-point, and adjusts either the Inlet or Exhaust valve accordingly in excess of two thousand times 
per second. 
It is most common to have a .050 inch diameter orifice in the inlet valve, and a .050 inch diameter 
exhaust valve. The response time of the system will depend on the size of the volume being controlled 
and the feed pressure. The controllers are intended for use with clean, non-corrosive gases only. 
They are designed with a feed port, a process port, and an exhaust port. This allows the controllers 
to raise and lower the pressure of a closed system within the operating range of the controller without 
wasting gas under constant pressure conditions.
Plumbing
Connect your PCD into your process via the 1/8” NPT port on the front of the unit. This is the 
“Process” port. 
Connect a supply pressure greater than the full scale pressure control range of the device, not to 
exceed 145 PSIG, to the inlet 1/8” NPT port on the left side device. This is the “Inlet” port. 
The 1/8” NPT “Exhaust” port, located on the right side of the device can vent to atmosphere if the 
application is suitable, or to a collection network if necessary. 
The pressure at the exhaust port should be at atmospheric pressure or below to allow the controller to 
be used over its full scale range. 
If desired, there are two 8-32 mounting holes located on the bottom of the unit as shown in the 
dimensional drawing on page 40. 
Connect your PCD to power and output lines as detailed in the “Wiring” section in this manual.

Figure 19.  PCD Plumbing Diagram
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 RS-232 / RS-485 Output and Input
Configuring HyperTerminal®:
1.	 Open your HyperTerminal® RS-232 / RS-485 terminal program (installed under the “Accessories” 

menu on all Microsoft Windows® operating systems).
2.	 Select “Properties” from the file menu.
3.	 Click on the “Configure” button under the “Connect To” tab. Be sure the program is set for: 19,200 

baud (or matches the baud rate selected in the RS-232 / RS-485 communications menu on the 
meter) and an 8-N-1-None (8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4.	 Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI or Auto Detect.
5.	 Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line Feeds” box is not 

checked and the “Echo Typed Characters Locally” box and the “Append Line Feeds to Incoming 
Lines” boxes are checked. Those settings not mentioned here are normally okay in the default 
position.

6.	 Save the settings, close HyperTerminal® and reopen it.
In Polling Mode, the screen should be blank except the blinking cursor. In order to get the data streaming to 
the screen, hit the “Enter” key several times to clear any extraneous information. Type “*@=@” followed 
by “Enter” (or using the RS-232 / RS-485 communication select menu, select @ as identifier and exit 
the screen). If data still does not appear, check all the connections and com port assignments.
Changing From Streaming to Polling Mode: 
When the meter is in the Streaming Mode (RS-485 units do not have a streaming mode), the screen is 
updated approximately 10-60 times per second (depending on the amount of data on each line) so that 
the user sees the data essentially in real time. It is sometimes desirable, and necessary when using 
more than one unit on a single RS-232 line, to be able to poll the unit.
In Polling Mode the unit measures the flow normally, but only sends a line of data when it is “polled”. 
Each unit can be given its own unique identifier or address. Unless otherwise specified each unit is 
shipped with a default address of capital A. Other valid addresses are B thru Z.
Once you have established communication with the unit and have a stream of information filling your 
screen:
1.	 Type *@=A followed by “Enter” (or using the RS-232 / RS-485 communication select menu, select 

A as identifier and exit the screen) to stop the streaming mode of information. Note that the flow of 
information will not stop while you are typing and you will not be able to read what you have typed. 
Also, the unit does not accept a backspace or delete in the line so it must be typed correctly. If in 
doubt, simply hit enter and start again. If the unit does not get exactly what it is expecting, it will 
ignore it. If the line has been typed correctly, the data will stop.

2.	 You may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll of unit 
A and returns the values once. You may type A “Enter” as many times as you like. Alternately you 
could resume streaming mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3.	 To assign the unit a new address, type *@=New Address, e.g. *@=B. Care should be taken not 
to assign an address to a unit if more than one unit is on the RS-232 / RS-485 line as all of the 
addresses will be reassigned. Instead, each should be individually attached to the RS-232 / RS-485 
line, given an address, and taken off. After each unit has been given a unique address, they can all 
be put back on the same line and polled individually.
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Tareing via RS-232 / RS-485 (Gauges only):
Tareing (or zeroing) the pressure gauge provides it with a reference point for zero pressure. This is a 
very simple but important step in obtaining accurate measurements. It is good practice to “zero” the 
pressure gauge each time it is powered up. If the pressure reading varies significantly from zero after 
an initial tare, give the unit a minute or so to warm up and re-zero it. 
Zeroing the unit while there is any pressure will directly affect the accuracy by providing a false zero 
point. If in doubt about whether the pressure is zero, remove it from the line and open both ports to 
atmosphere before entering the Tare command. 
If the unit reads a significant negative value when removed from the line and open, it is a good indication 
that it was given a false zero. To send a Tare command via RS-232 / RS-485, enter the following 
strings:

In Streaming Mode:		 $$P<Enter>
In Polling Mode:		  Address$$P<Enter>        (e.g. B$$P<Enter>)

Sending a Set-point via RS-232 / RS-485 (Controllers only):
To send a set-point via RS-232 / RS-485, “Serial” must be selected under the “Input” list in the control 
set up mode. To give controllers a set-point, or change an existing point, simply type in a number 
between 0 and 65535 (2% over range), where 64000 denotes full-scale pressure, and hit “Enter”. 
The set-point column and pressure rates should change accordingly. If they do not, try hitting “Enter” 
a couple of times and repeating your command. The formula for performing a linear interpolation is as 
follows:

Value = (Desired Set-point X 64000) / Full Scale Pressure Range
For example, if your device is a 50 PSIG full-scale unit and you wish to apply a set-point of 12.5 PSIG 
you would enter the following value:
 	 16000 = (12.5 PSIG X 64000) / Full Scale Pressure Range
If the controller is in polling mode as described in Changing from Streaming Mode to Polling Mode, the 
set-point must be preceded by the address of the controller. For example, if your controller has been 
given an address of D, the set-point above would be sent by typing:
 	 D16000 followed by “Enter”
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Adjusting the Proportional and Differential (P&D) Terms via RS-232 / RS-485 (Controllers only):
Type *@=A followed by “Enter” to stop the streaming mode of information.
To adjust the “P” or proportional term of the PID controller, type *R21   followed by “Enter”.
The computer will respond by reading the current value for register 21 between 0-65535. It is good 
practice to write this value down so you can return to the factory settings if necessary. 
Enter the value you wish to try by writing the new value to register 21. For example, if you wished to try 
a “P” term of 220, you would type *W21=220 followed by “Enter” where the bold number denotes the 
new value.
The computer will respond to the new value by confirming that 21=220. To see the effect of the change 
you may now poll the unit by typing A followed by “Enter”. 
This does an instantaneous poll and returns the values once. You may type A “Enter” as many times as 
you like. Alternately, you could resume streaming mode by typing *@=@ followed by “Enter”. Repeat 
step 3 to remove the unit from the streaming mode.
To adjust the “D” or proportional term of the PID controller, type *R22 followed by “Enter”.
The computer will respond by reading the current value for register 22 between 0-65535. It is good 
practice to write this value down so you can return to the factory settings if necessary. Enter the value 
you wish to try by writing the new value to register 22. 
For example, if you wished to try a “D” term of 25, you would type *W22=25 followed by “Enter” where 
the bold number denotes the new value.
The computer will respond to the new value by confirming that 22=25. To see the effect of the change 
you may now poll the unit by typing A followed by “Enter”. 
This does an instantaneous poll and returns the values once. You may type A “Enter” as many times as 
you like. Alternately you could resume streaming mode by typing *@=@ followed by “Enter”. Repeat.
You may test your settings for a step change by changing the set-point. To do this type A32000 (A is 
the default single unit address, if you have multiple addressed units on your RS-232/ RS-485 line the 
letter preceding the value would change accordingly.) followed by “Enter” to give the unit a ½ full scale 
set-point. 
Monitor the unit’s response to the step change to ensure it is satisfactory for your needs. Recall that the 
“P” term controls how quickly the unit goes from one set-point to the next, and the “D” term controls how 
quickly the signal begins to “decelerate” as it approaches the new set-point (controls the overshoot).
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Collecting Data
The RS-232 / RS-485 output updates to the screen many times per second. Very short-term events 
can be captured simply by disconnecting (there are two telephone symbol icons at the top of the 
HyperTerminal® screen for disconnecting and connecting) immediately after the event in question. The 
scroll bar can be driven up to the event and all of the data associated with the event can be selected, 
copied, and pasted into Microsoft® Excel® or other spreadsheet program as described below.
For longer term data, it is useful to capture the data in a text file. With the desired data streaming to the 
screen, select “Capture Text” from the Transfer Menu. Type in the path and file name you wish to use. 
Push the start button. When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.
Data that is selected and copied, either directly from HyperTerminal® or from a text file can be pasted 
directly into Excel®. When the data is pasted it will all be in the selected column. Select “Text to 
Columns...” under the Data menu in Excel® and a Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the first dialog box and click “Next”. 
In the second dialog box, set the column widths as desired, but the default is usually acceptable. Click 
on “Next” again.  In the third dialog box, make sure the column data format is set to “General”, and click 
“Finish”. This separates the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or manipulated as desired. 
For extended term data capture see: “Sending a Simple Script to HyperTerminal®” on page 31.

Data Format:
The data stream on the screen represents the pressure parameters of the main mode in the units 
shown on the display. For P Series Pressure Gauges, there is a single column of data. This column 
represents the measured pressure in the units specified at time of order and shown on the display.

+4.123
+4.123
+4.123
+4.123
+4.124
+4.125

P Series Pressure Gauge Data Format

For PC Series Controllers, there are 2 columns of data representing pressure and set-point. The first 
column is pressure (normally in PSIG), the second column is the set-point (in the units specified at time 
of order and shown on the display).

+014.70  +014.70
+014.70  +014.70
+014.70  +014.70
+014.70  +014.70
+014.70  +014.70
+014.70  +014.70

PC Series Vacuum and Pressure Controller Data Format
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard streaming mode 
information is useful for short term events, however, when capturing data for an extended period of 
time, the amount of data and thus the file size can become too large very quickly. Without any special 
programming skills, the user can use HyperTerminal® and a text editing program such as Microsoft® 
Word® to capture text at user defined intervals.
1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS Word, you can tell how 
many lines you have by the line count at the bottom of the screen. The number of lines will correspond to the 
total number of times the device will be polled, and thus the total number of lines of data it will produce.
For example:	A

	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the pressure gauge, but you can enter as many as you 
like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select save. In the save dialog 
box, enter a path and file name as desired and in the “Save as Type” box, select the plain text (.txt) 
option. It is important that it be saved as a generic text file for HyperTerminal to work with it.
5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select CR Only. Everything 
else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file and exit the text editing 
program.
9. Open HyperTerminal and establish communication with your pressure device as outlined in the 
manual.
10. Set the pressure device to Polling Mode as described in the manual. Each time you type A<Enter>, 
the gauge should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell the program how often 
to read a line from the script file you’ve created. 1000 milliseconds is one second, so if you want a line 
of data every 30 seconds, you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.
15. When you have entered the value you want, click on OK and OK in the Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time with the line delay you 
specified and the pressure device will respond by sending one line of data for each poll it receives, 
when it receives it.
You can also capture the data to another file as described in the manual under “Collecting Data”. You 
will be simultaneously sending it a script file and capturing the output to a separate file for analysis.
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage.

Pressure reading is approximately fixed either near zero or near full scale regardless of actual 
line pressure.
The pressure sensor may be damaged. Damage due to excessive pressure is not covered by warranty.

Displayed pressure is flashing and message POV is displayed:
Our pressure gauges and controllers display an error message (POV = pressure overrange) when a 
the pressure exceeds the range of the sensors in the device. When any item flashes on the display, the 
pressure measurement is not accurate. Reducing the pressure to within specified limits will return the 
unit to normal operation and accuracy.

My controller does not respond to the set-point.
Check the control set up screen to be sure the Input parameter selection matches the set-point you are 
trying to use. Also, be sure that the unit was ordered for the type of analog signal you are trying to use.

After installation, there is no pressure.
Alicat Scientific PC Series Controllers incorporate normally closed valves and require a set-point to 
operate. Check that your set-point signal is present and supplied to the correct pin and that the correct 
input is selected under the Input list in the control set up mode screen. Also check that the unit is 
properly grounded.

The pressure lags below the set-point.
Be sure there is enough pressure available. If either the set-point signal line and/or the output signal 
line is relatively long, it may be necessary to provide heavier wires (especially ground wiring) to negate 
voltage drops due to line wire length. An inappropriate PID tuning can also cause this symptom if the D 
term is too large relative to the P term. 

Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions considerably different than 
those at which the device was originally set up can necessitate a re-tuning of the PID loop. Note: The 
larger the volume pressured, the longer it takes to change the pressure in that volume.

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the gauge/controller as voltage 
drops in the wires increase with distance. Using heavier gauge wires, especially in the ground wire, can 
reduce this effect.

My controller oscillates wildly and/or exhibits very different reactions to the set-point than I expect.
Conditions considerably different than those at which the device was originally set up can necessitate 
a re-tuning of the PID loop.

RS-232  / RS-485 Serial Communications is not responding.
Check that your gauge is powered and connected properly. Be sure that the port on the computer 
to which the gauge is connected is active. Confirm that the port settings are correct per the RS-232 
/ RS‑485 instructions in this manual (Check the RS-232 / RS-485 communications select screen for 
current gauge readings). Close HyperTerminal® and reopen it. Reboot your PC.
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Slower response than specified.
P Series Gauges and PC Series Controllers feature an RS-232 / RS-485 programmable Geometric 
Running Average (GRA). Depending on the full scale range of the gauge, it may have the GRA set to 
enhance the stability/readability of the display, which would result in slower perceived response time. 
Please see “Pressure Averaging” and “Flow Averaging” on page 16.

Jumps to zero at low pressure.
P Series Gauges and PC Series Controllers feature an RS-232 / RS-485 programmable zero deadband. 
The factory setting is usually 0.5% of full scale. This can be adjusted between NONE and 3.2% of full 
scale. See “Display Zero Deadband” on page 16.

Maintenance and Recalibration
General: P, PC, PCR and PCD Series Pressure Gauges and Controllers require minimal maintenance. 
The devices are designed to measure CLEAN, NON-CORROSIVE gases and fluids.
Recalibration: The recommended period for recalibration is once every year. Providing that the CLEAN, 
NON-CORROSIVE mantra is observed, this periodic recalibration is sufficient. A label located on the 
back of the device lists the most recent calibration date. The device should be returned to the factory 
for recalibration within one year from the listed date. Before calling to schedule a recalibration, please 
note the serial number on the back of the device. The Serial Number, Model Number, and Date of 
Manufacture are also available on the Manufacture Data 2 display (see page 15).
Cleaning: P, PC, PCR and PCD Series instruments require no periodic cleaning. If necessary, the 
outside of the instrument can be cleaned with a soft dry cloth. Avoid excess moisture or solvents.
For repairs, recalibrations, or recycling of this product, contact:

Alicat Scientific, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Ph. 520-290-6060
Fax 520-290-0109

email: info@alicatscientific.com
Web site: www.alicatscientific.com

Pressure Conversion Table
PSI 1.00 = 51.7150 mmHg
PSI 1.00 = 2.0360 inHg
PSI 1.00 = 27.7080 inH20
PSI 1.00 = 68.9480 mbar
PSI 100.00 = 6.8046 atm
PSI 1.00 = 51.7150 torr
PSI 1.00 = 6.8948 kPa

mmHg 100.00 = 3.9370 inHg
mmHg 100 = 1.9337 PSI

inHg 100 = 49.1159 PSI
inH2O 100 = 3.6091 PSI
mbar 100 = 1.4504 PSI

atm 1 = 14.6959 PSI
torr 100 = 1.9337 PSI
kPa 100 = 14.5037 PSI

inHg 1 = 25.4000 mmHg
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Dimensional Drawings: pages 36 to 39 

Specification P Series PC & PCR Series Description
Full scale pressure < 2” H2O 

Accuracy Consult Factory Full Scale
Full scale pressure ≥ 2” H2O 

Standard Accuracy ± 0.25% Full Scale
Full scale pressure ≥ 2” H2O 

High Accuracy Option ± 0.125% Full Scale

Repeatability ± 0.08% Full Scale
Turndown Ratio 200:1

Adjustable Response Time1 5 100 Milliseconds
Operating Temperature −10 to +50 Degree Celsius

Zero Shift 0.02% Full Scale / °Celsius
Span Shift 0.02% Full Scale / °Celsius

Excess Pressure 128% Measurable 102.4% Controllable Full Scale
Burst Pressure 3X Full Scale

Supply Current Peak 0.035 0.250   (PCR: 0.750) Amp

Supply Voltage 7 – 30 12 – 30  
(PCR Series = 24 – 30) Volts dc

Input /Output Signal Standard RS-232 Serial & 0-5Vdc or PROFIBUS or DeviceNet2

Electrical Connections 8 Pin Mini-DIN or DB-15

Wetted Materials3 302 & 303 Stainless Steel, Viton®. Silicone RTV, Silicon, Glass. All Controllers add:  400 
Series Stainless Steel. PC Series Controllers only add: Brass

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet no analog signal is available.  PROFIBUS and DeviceNet units do not have the display.  

See PROFIBUS or DeviceNet specifications for supply voltages and supply currents.
3. If your application demands a different material, please contact Application Assistance for available options.

Technical Data for Pressure Gauges and Single Valve Pressure Controllers
The following specifications are for the standard configuration of the Alicat product as shipped from the factory. There are many 
customization options available. PCR Series high flow pressure controllers are for applications with required flows above 20LPM. Please 
contact Application Assistance for additional PCR operating specifications.

Operating Specifications

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

P Series Gauges 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female
PC Series Controllers 4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

PCR Series Controllers 5.5”H x 2.9”W x 5.5”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect & compression adapter fittings. Alternates available.

P Series Gauges PC, PCR Series 
Controllers

-15PSIG to 0PSIG -15PSIG to 0PSIG

2inH2OD 2inH2OG 2inH2OD 2inH2OG

4inH2OD 4inH2OG 4inH2OD 4inH2OG

1PSID 1PSIG 1PSID 1PSIG

5PSID 5PSIG 5PSID 5PSIG

15PSID 15PSIG 15PSIA 15PSID 15PSIG 15PSIA

30PSID 30PSIG 30PSIA 30PSID 30PSIG 30PSIA

100PSID 100PSIG 100PSIA 100PSID 100PSIG 100PSIA

150PSID 300PSIA 150PSID 300PSIA

Other ranges available. Please contact Application Assistance.

Select One Unit of Measure when Ordering

PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
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Dimensional Drawings: page 40 & 41

Technical Data for Dual Valve Pressure Controllers
The following specifications are for the standard configuration of the Alicat product as shipped from the factory. There are many 
customization options available.
Operating Specifications

Specification PCD Series Description
Full scale pressure < 2” H2O 

Accuracy Consult Factory Full Scale

Full scale pressure ≥ 2” H2O 
Standard  Accuracy ± 0.25% Full Scale

Full scale pressure ≥ 2” H2O 
High Accuracy Option ± 0.125% Full Scale

Feed Valve Orifice 0.050 Inches
Exhaust Valve Orifice 0.050 Inches

Alternate Valve Orifices Available 0.010 or 0.030 Inches
Repeatability ± 0.08% Full Scale

Turndown Ratio 200:1
Adjustable Response Time1 ≤100 Milliseconds

Operating Temperature −10 to +50 Degree Celsius
Zero Shift 0.02% Full Scale / °Celsius

Span Shift 0.02% Full Scale / °Celsius
Excess Pressure 102.4% Controllable Full Scale

Burst Pressure ≥3X Full Scale
Supply Current Peak 0.250 Amp

Supply Current Average 0.050 Amp
Supply Voltage 12 – 30 Volts dc

Input /Output Signal Standard RS-232 Serial & 0-5Vdc or PROFIBUS or DeviceNet2

Electrical Connections 8 Pin Mini-DIN or DB-15

Wetted Materials3 302 & 303 Stainless Steel, Viton®, Silicone RTV, Brass, 400 Series Stainless Steel 
(standard units are for non-corrosive gases), Silicon, Glass.

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet no analog signal is available.  PROFIBUS and DeviceNet units do not have the display.  

See PROFIBUS or DeviceNet specifications for supply voltages and supply currents.  Please contact Applications Assistance 
for PCD - PROFIBUS or DeviceNet options.

3. If your application demands a different material, please contact Application Assistance for available options.

PCD Series Dual Valve Controller Mechanical
Dimensions 

Process
Connections1 

All Standard Ranges 4.1”H x 4.8”W x 1.1”D 1/8” NPT Female
1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.

Standard Available Ranges

PCD Series Pressure Controllers

-15PSIG to 0PSIG

2inH2OD 2inH2OG

4inH2OD 4inH2OG

1PSID 1PSIG

5PSID 5PSIG

15PSID 15PSIG 15PSIA

30PSID 30PSIG 30PSIA

100PSID 100PSIG 100PSIA

150PSID 300PSIA

Other ranges available.
Please contact Application Assistance.

Select One Unit of Measure when Ordering

PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Mechanical Specifications
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





 









  

 











 







  








  














P Series:
All standard ranges

P Series:
Differential Pressure
All standard ranges
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


















 











 





































PC Series:
All standard ranges

PC Series:
Differential Pressure
All standard ranges
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






















 






 









 















 


 







 

PC3 Series:
All standard ranges

PCR3 Series:
All standard ranges
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























 



















 































PCR Series:
Most standard ranges

PCR Series:
Differential Pressure 5inH2O
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
























 

 





















  







 












 








PCD Series:
All standard ranges

PCD Series:
Differential Pressure
All standard ranges
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



 































  

 

PCD Series:
1 inch H2O
All standard ranges
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Technical Data for Alicat PS Series Pressure and Vacuum Gauges
Alicat PS instruments are built for use with aggressive gases. For the most part these instruments 
maintain the specifications of equivalently ranged P Series devices. 
In addition to all non-corrosive gases, PS Gauges are configured to operate with the following 
aggressive gases. 

PS Gauge Aggressive Gas Compatibility List :
NO 		  Nitric Oxide to 100%
NF3 		  Nitrogen Triflouride to 100%
NH3 		  Ammonia to 100%
NO2 		  Nitrogen Dioxide to 100%
Cl2 		  Chlorine  to 100%
H2S 		  Hydrogen Sulfide to 100%
SO2 		  Sulfur Dioxide to 100%
Propylene to 100%

In addition the following gases are available upon request:
Refrigerant gases to 100% (refrigerant gases my require custom seals, consult Alicat)

If your application requires another gas or gas mixture, please contact Alicat. We will do our best to 
accommodate your request.

Technical Data for Alicat PCS, PCRS and PCDS Series 
Pressure and Vacuum Controllers

Alicat PCS, PCRS and PCDS instruments are built for use with aggressive gases. For the most part 
these instruments maintain the specifications of equivalently ranged PC, PCR and PCD Series devices. 
In addition to all non-corrosive gases, PCS, PCRS and PCDS controllers are configured to operate with 
the following aggressive gases.
 PCS, PCRS & PCDS Controller Aggressive Gas Compatibility List :

NO 		  Nitric Oxide to 100%
NF3 		  Nitrogen Triflouride to 100%
NH3 		  Ammonia to 100%
NO2 		  Nitrogen Dioxide to 100%
H2S 		  Hydrogen Sulfide to 100% (22°C and under)
Propylene to 100%

In addition, the following gases are available upon request:
Refrigerant gases to 100% (refrigerant gases my require custom seals, consult Alicat)
Other gases to 1000 ppm in an inert carrier

If your application requires another gas or gas mixture, please contact Alicat. We will do our best to 
accommodate your request.

USING PS, PCS, and PCRS INSTRUMENTS with FLUIDS
PS, PCS and PCRS devices may be used with chemically compatible liquids. Please contact Alicat for 
technical assistance if your application involves fluids.
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Specification PS Series PCS & PCRS Series Description
Standard Accuracy ± 0.25% Full Scale

High Accuracy Option ± 0.125% Full Scale
Repeatability ± 0.08% Full Scale

Turndown Ratio 200:1
Adjustable Response Time1 5 100 Milliseconds

Operating Temperature −10 to +50 Degree Celsius
Zero Shift 0.02% Full Scale / °Celsius

Span Shift 0.02% Full Scale / °Celsius
Excess Pressure 128% Measurable 102.4% Controllable Full Scale

Burst Pressure 3X Full Scale
Supply Current Peak 0.035 0.250   (PCRS: 0.750) Amp

Supply Voltage 7 – 30 12 – 30  
(PCRS Series = 24 – 30) Volts dc

Input /Output Signal Standard RS-232 or RS-485 Serial & 0-5Vdc  
or PROFIBUS or DeviceNet2

Electrical Connections 8 Pin Mini-DIN or DB-15

Wetted Materials3 316LSS, FFKM (Kalrez) standard; Viton, EPDM, Buna, Neoprene as needed for some 
gases.  PCS, PCRS Series Controllers add: 303SS, 430FRSS

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet no analog signal is available.  PROFIBUS and DeviceNet units do not have the display.  

See PROFIBUS or DeviceNet specifications for supply voltages and supply currents.
3. If your application demands a different material, please contact Application Assistance for available options.

Technical Data for PS Pressure Gauges and 
PCS and PCRS Single Valve Pressure Controllers

The following specifications are for the standard configuration of the product. There are many low-cost customization options available. 
PCRS Series high flow pressure controllers are for applications with required flows above 20LPM. Please contact Application Assistance 
for additional PCRS operating specifications.

Operating Specifications

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

PS Series Gauges ≤ 100PSIG 3.8”H x 2.4”W x 1.1”D 1/8” NPT Female

PS Series Gauges > 100PSIG 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female
PCS Series Controllers ≤ 100PSIG 3.8”H x 3.6”W x 1.1”D 1/8” NPT Female
PCS Series Controllers > 100PSIG 4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

PCRS Series Controllers 5.5”H x 2.9”W x 5.5”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect & compression adapter fittings. Alternates available.

PS Series Gauges PCS, PCRS Series Controllers

-15PSIG to 0PSIG -15PSIG to 0PSIG

1PSID 1PSIG 1PSID 1PSIG

5PSID 5PSIG 5PSID 5PSIG

15PSID 15PSIG 15PSIA 15PSID 15PSIG 15PSIA

30PSID 30PSIG 30PSIA 30PSID 30PSIG 30PSIA

100PSID 100PSIG 100PSIA 100PSID 100PSIG 100PSIA

150PSID 300PSIA 150PSID 300PSIA
Other ranges available. Please contact Application Assistance.
Differential pressure ranges may be subject to extended lead times, please 
contact Application Assistance.

Select One Unit of Measure when Ordering

PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges

Dimensional Drawings: page 45 & 46
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Technical Data for PCDS Dual Valve Pressure Controllers
The following specifications are for the standard configuration of the product. There are many low-cost customization options available.

Specification PCDS Series Description

Standard  Accuracy ± 0.25% Full Scale

High Accuracy Option ± 0.125% Full Scale

Feed Valve Orifice 0.050 Inches
Exhaust Valve Orifice 0.050 Inches

Alternate Valve Orifices Available 0.010 or 0.030 Inches
Repeatability ± 0.08% Full Scale

Turndown Ratio 200:1
Adjustable Response Time1 ≤100 Milliseconds

Operating Temperature −10 to +50 Degree Celsius
Zero Shift 0.02% Full Scale / °Celsius

Span Shift 0.02% Full Scale / °Celsius
Excess Pressure 102.4% Controllable Full Scale

Burst Pressure ≥3X Full Scale
Supply Current Peak 0.250 Amp

Supply Current Average 0.050 Amp
Supply Voltage 12 – 30 Volts dc

Input /Output Signal Standard RS-232 or RS-485 Serial & 0-5Vdc  
or PROFIBUS or DeviceNet2

Electrical Connections 8 Pin Mini-DIN or DB-15

Wetted Materials3 316LSS, 303SS, 430FRSS, FFKM (Kalrez) standard; Viton, EPDM, Buna, Neoprene 
as needed for some gases.

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.
2. If selecting PROFIBUS or DeviceNet no analog signal is available.  PROFIBUS and DeviceNet units do not have the display.  

See PROFIBUS or DeviceNet specifications for supply voltages and supply currents.  Please contact Applications Assistance 
for PCD - PROFIBUS or DeviceNet options.

3. If your application demands a different material, please contact Application Assistance for available options.

PCDS Series Dual Valve Controller Mechanical
Dimensions 

Process
Connections1 

All Standard Ranges 4.1”H x 4.8”W x 1.1”D 1/8” NPT Female
1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.

Standard Available Ranges

PCDS Series Pressure Controllers

-15PSIG to 0PSIG

1PSID 1PSIG

5PSID 5PSIG

15PSID 15PSIG 15PSIA

30PSID 30PSIG 30PSIA

100PSID 100PSIG 100PSIA

150PSID 300PSIA
Other ranges available.Please contact Application Assistance. 
Differential pressure ranges may be subject to extended lead times, 
please contact Application Assistance.

Select One Unit of Measure when Ordering

PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Mechanical Specifications

Operating Specifications

Dimensional Drawing: page 46
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



















  






  



PS Series:
All standard ranges 
to 500PSIG








  






















 
 

PCS Series:
All standard ranges 
to 500PSIG
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


 

 

 







 




























  



















PCRS Series:
Most standard ranges

PCDS Series:
Most standard ranges
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2 x 8-32 UNC ┬v  .350

.525

.35

4.264.08

3.76

3.59

1/8 NPT
Both Sides

1.05

.525

.35

2.225
.150 .125

.925

PROFIBUS

DP-V1 Compatible

Instrument

Specification Meter  or 
Gauge

Small Valve
Controller

Large Valve
Controller Description

Input /Output Signal Digital PROFIBUS DP

Electrical Connections DB9
Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 780mA @ 24Vdc

Technical Data for PROFIBUS Meters, Gauges and Controllers
NOTICE: The following specifications are applicable to Alicat PROFIBUS enabled meters, gauges and 
controllers only. 
All other operating specifications are shown in the Technical Data page for standard Alicat instruments.
All standard device features and functions are available and operate in accordance with the Alicat 
operating manual provided with the device. 

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDEPower and Signal Connections:
Connect to the device using two DB9 connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and 
RS‑232 or RS-485.
Pin out diagrams for all PROFIBUS enabled Alicat 
devices are shown:

MC-1SLPM-PROFIBUS

PROFIBUS MC1SLPM shown to provide PROFIBUS connector dimensions only. Flow body 
and valve dimensions will vary with range. Please see Alicat’s device specifications for complete 

dimensions. PROFIBUS units do not have a display screen.
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Information for Alicat DeviceNet Compatible Instruments
DeviceNet OVERVIEW
Alicat DeviceNet compatible instruments support the Predefined Master/Slave Connection Set.
There are three connectors on the Alicat meter/controller. Only one of the connections is required for 
DeviceNet operations. This is a DeviceNet standard M12 Micro Connector. The other two connectors 
are provided for convenience and are not necessary for operation of the DeviceNet compatible Alicat 
meter/controller.
One of the convenience connectors is a standard DC power jack which can provide power to the unit. 
The other is a DB9 which can be used for RS-232 communication.
DeviceNet CONNECTION
Utilizing the standard DeviceNet M12 micro connector allows the Alicat meter/controller to be easily 
attached to a DeviceNet network.
The pin out as defined in Volume Three of the DeviceNet Standard applies and is repeated here.

PIN Description Wire Color
1 Drain Bare
2 V+ (24VDC) RED
3 V- (GND) BLACK
4 CAN-H WHITE
5 CAN-L BLUE

MAC ID
All devices on a DeviceNet must have unique MAC ID. Alicat units can either be programmed with a 
customer requested ID or they will be defaulted to 63. In either case when an Alicat unit is attached to 
a DeviceNet and powered up it will send out a duplicate MAC request. 
If there already is a device on the network with the same address, the Alicat device will decrement its 
address and try again until it finds an unoccupied address. Once it finds a unique address, it stores that 
address into its nonvolatile memory, enabling it to come back on at the same address.

BAUD RATE
The following baud rates are available:		  125K		  250K		  500K
The default baud rate is 125K Baud. You may specify the baud rate at the time of order. 
The baud rate can be changed by using a set attribute single DeviceNet service request to the DeviceNet 
Object Class 03 Instance 01 Attribute ID 02. 
A setting of 0 is 125K baud, 1 is 250K baud, and 2 is 500K baud. In order for a change of baud rate to 
take affect the unit will have to be power cycled.

SUPPORTED DEVICE TYPE: Mass Flow Controller Device Type 0x1A 

SUPPORTED CLASSES: Identity Object Class 0x01 
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SUPPORTED ATTRIBUTES:

Attribute Services Description Default Value
1 Get Vendor ID 1174 (0x0496)
2 Get Device Type 0x1A (Mass Flow)
3 Get Product Code See Product Codes
4 Get Revision (Maj, Min) 0x01,0x01
5 Get Status 0x00
6 Get Serial Number 0x########
7 Get Product Name Alicat Scientific Inc MFC

DeviceNet Object Class 0x03			   DeviceNet Assembly Object Class 0x04
Connection Object Class 0x05			   S-Device Supervisor Class 0x30

DeviceNet MC10SLPM shown to provide DeviceNet connector dimensions only. Flow body and valve 
dimensions will vary with range. Please see Alicat’s device specifications for complete dimensions.

DeviceNet units do not have a display screen.

Specification Meter  or 
Gauge

Small Valve
Controller

Large Valve
Controller Description

Input /Output Signal Digital DeviceNet
Electrical Connections M12 Micro Connector

Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 780mA @ 24Vdc

Technical Data for DeviceNet Meters, Gauges and Controllers
NOTICE: The following specifications are applicable to Alicat DeviceNet enabled meters, gauges and controllers only. 
All other operating specifications are shown in the Technical Data page for standard Alicat instruments.
All standard device features and functions are available and operate in accordance with the Alicat operating 
manual provided with the device. 
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Alicat Portable Meters and Gauges
Alicat Portable Flow Meters and Gauges use a common 9 Volt battery located in the top section of your meter. 
Output signals from the flow meter are passed through the female connector on top of the flow meter. 
Turn the switch on top of the flow meter “off” when the meter is not in use.
Normal (9V alkaline) battery life is approximately 8 hours (30-40 hours with a 9V-lithium battery), 
however many factors can affect this. 
Note: Alicat recommends the use of non-rechargeable 9V-lithium batteries in all MB TFT (color display 
portable) meters and gauges. 
Replace the battery as often as required. A yellow LED indicates low voltage and that the battery should 
be replaced. 
A false signal can result when the voltage drops below its normally regulated level. 
Alicat Portable Flow Meters and Gauges can also be powered by an optional AC/DC plug-in wall adaptor. 
With the adaptor plugged into the flow meter, the battery is bypassed and the meter will operate solely 
off the adaptor power supply.

Replacing the Battery:  
1.	 Remove the four Phillips head screws from the front cover and gently remove it as shown below.
2.	 Remove the 9V battery, pulling the top of the battery out first.
3.	 Disconnect the old battery from the harness and replace it with a new battery.
4.	 Install the new battery bottom end first and replace the back cover so that the cushioning pad 

presses directly down on the battery.
5.	 Replace the four Phillips head screws.

Battery cover removal



















       

 


























2045 N. Forbes Blvd. Suite 103  Tucson, AZ 85745
520-290-6060 Ph.  520-290-0109 Fax













Alicat Scientific, Inc.


 










Rev. No. Description Date

AC/DC Adaptor Port
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Option: Remote Electronics for High Line or Gas Temperatures
Some applications involve operating temperatures outside the standard Alicat device specifi cations. 
A solution using remote electronics is available. (This option is not applicable for liquid devices.)
The fl ow body’s components are minimized to only the required 
sensors. The fl ow data is sent to the microprocessor electronics 
up to 6 feet away from the sensor package. 
Relocating the sensitive electronics, including the LCD, allows 
for installation of the fl ow body in ambient temperatures as high 
as 85° Celsius with gas temperatures under 100°Celsius. 
In these applications we recommend our custom gauge calibration 
at a gas temperature of up to 70°Celsius. 
This will reduce zero shift errors that occur when actual gas 
fl ow temperatures deviate substantially from the gas calibration 
temperature. 
This confi guration is also used in integrations that require a 
compact fl ow package at the installation point.

Accessory: BB9 Multi-Drop Box
The BB9 Multi-Drop Box makes it convenient to wire multiple fl ow and/or pressure 
devices to a single RS-232 or RS-485 port.
The Multi-Drop Box has nine 8 pin mini-DIN ports available. The ports are to be 
used with a standard double ended 8 pin mini-DIN (DC-62) style cable going from 
the box to each fl ow or pressure device. 
A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the fl ow and/or pressure devices are powered via a terminal block on the front of the box. 
If more than nine devices will be required, additional Multi-Drop Boxes can be daisy chained together 
with a double ended 8 pin mini-DIN cable plugged into any receptacle on both boxes.
BB9 Power Supply for Large Valve Controllers: The PS24VHC (Power Supply 24Vdc High Current) 
is a 6.5Amp 24Vdc power supply designed for running multiple large controllers on a BB9. 
The 6.5Amp power supply can run as many as 8 large valve controllers, which makes it ideal for the 
BB9 and multiple large valve (or small valve / large valve combination) controllers on a BB9.

Option: Remote Panel Display 
Our Remote Display option offers the fl exibility of using Alicat’s display with 
units that are embedded inside processes or instrument enclosures. 
The Remote Display retains all of the same features as our standard 
display.
The Remote Display is ideal for:
►  OEMs Remote Panel Mounting ►  Embedded Systems
►  Gas Panels    ►  Fuel Cell Test Stations
►  Leak Detection Systems  ►  Artifi cial Environments
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help 
your test cycles run smoother and shorten your engineering time! 

Flow Vision™ SC lets you connect to and communicate 
with multiple Alicat units simultaneously. Now you can view virtual 
displays, control tabs, charts and data lines from every connected 
Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial 
communication functions, including: gas selection, tareing, 
set‑point control, valve tuning and flow averaging.

Session Saving: Save and reload your configuration data with confidence. 

Script Building: Create scripts to adjust a controller’s set-point value at variable specified time intervals.

Charting: Chart as many parameters as you want off as many devices as you want, with color coding, 
zooming, and printing functionality.

Alarms: Create software alarms that will notify you of given parameter conditions.

Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. Improved Data Logging 
and Data Log File Splitting for easy to manage data.

Flow Vision™ SC supports multiple devices connected to 
the same RS-232 or RS-485 port.
Now you can easily monitor and control multiple Alicat 
instruments from your computer. 
Simply connect each device to a BB9 Multi‑Drop Box, 
then using device addressability, assign an identifier to each 
instrument.

Devices

Scripts

Data Logs

Charts

Terminals
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Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments
BB9 Multi-Drop Box
PS24VHC High current power supply for BB9 use with Large Valve Controllers
PCASE Industrial carry and storage case for portable meters/gauges
DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length
DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length
DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length
DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length
DC-751 8 Pin Male Mini-DIN connector cable, single ended, 70 foot length
DC-6RT 8 Pin Male Right Angle Mini-Din Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length
DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length
MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length
IC10 Industrial cable, 6 Pin, single ended, 10 foot length
IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length
IC20 Industrial cable, 6 Pin, single ended, 20 foot length
IC24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length
IC50 Industrial cable, 6 Pin, single ended, 50 foot length
PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter
USB-RS232 RS-232 to USB Converter
REMOTE Remote Electronics with Display
RD Remote Panel Mount Display

MNPT to Compression Fittings
10-32 - 1/8” SS-200-1-0157
10-32 - 1/4” SS-400-1-0256
1/8” - 1/8” SS-200-1-2
1/8” - 1/4” SS-400-1-2
1/8” - 3/8” SS-600-1-2
1/8” - 1/2” SS-810-1-2
1/8” - 3mm SS-3M0-1-2
1/8” - 4mm SS-4M0-1-2
1/8” - 6mm SS-6M0-1-2
1/8” - 8mm SS-8M0-1-2
1/8” - 12mm SS-12M0-1-2
1/4” - 1/8” SS-200-1-4
1/4” - 1/4” SS-400-1-4
1/4” - 3/8” SS-600-1-4
1/4” - 1/2” SS-810-1-4
1/4” - 3mm SS-3M0-1-4
1/4” - 4mm SS-4M0-1-4
1/4” - 6mm SS-6M0-1-4
1/4” - 8mm SS-8M0-1-4
1/4” - 12mm SS-12M0-1-4

Filters & Elements FNPT-MNPT
10-32 5μ 510053
10-32 20μ 510054
1/8” 20μ ILF-1/8-20
1/4” 40μ ILF-1/4-40
1/2” 40μ ILF-1/2-40*
3/4” 40μ ILF-3/4-40*

20μ element ILFE20
40μ element ILFE40
40μ element ILFE40L*

Filters & Elements FNPT-FNPT*
10-32 5μ CF-303-20-316

*requires MNPT to MNPT coupler 
to interface with Alicat flow bodies

10-32 Male UNF to 1/8 FNPT Adapter
410133

Male M5 (10-32) Buna-N O-ring face seal to 1/8”Female NPT

MNPT to Compression Fittings
1/2” - 1/8” SS-200-1-8
1/2” - 1/4” SS-400-1-8
1/2” - 3/8” SS-600-1-8
1/2” - 1/2” SS-810-1-8
1/2” - 3/4” SS-1210-1-8
1/2” - 6mm SS-6M0-1-8
1/2” - 8mm SS-8M0-1-8
1/2” - 12mm SS-12M0-1-8
1/2” - 16mm SS-16M0-1-8
3/4” - 1/4” SS-400-1-12
3/4” - 1/2” SS-810-1-12
3/4” - 3/4” SS-1210-1-12

3/4” - 12mm SS-12M0-1-12
3/4” - 16mm SS-16M0-1-12
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Mini-DIN to DB-9 Connection for RS-232 / RS-485 Signals
RS-232 / RS-485 Digital Output Signal
If you will be using the RS-232 / RS-485 output signal, it is necessary to connect the RS-232 / RS-485 
Output Signal (Pin 5), the RS-232 / RS-485 Input Signal (Pin 3), and Ground (Pin 8) to your computer 
serial port as shown in above. Adapter cables are available from the manufacturer or they can be 
constructed in the field with parts from an electronics supply house. 
Note that the diagrams represent the “port” side of the connections, i.e. the connector on top of the 
meter and the physical DB-9 serial port on the back of the computer. The cable ends will be mirror 
images of the diagram. 

Eight Pin Mini-DIN Connector Pin-Outs
If your Alicat Instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

7

4

6

21

DB-9 Serial Port

5

5----------Ground--------------------------------------Ground----------8
3----------Transmit------------------------------------Receive---------3
2----------Receive-------------------------------------Transmit--------5

8 Pin Mini-DIN Port

8

1 2 3 4 5

6 7 8 9
3

 

4 5

6 7 8

2

3

1

5----------Ground--------------------------------------Ground----------8
3----------Transmit-------------------------------------Receive---------3
2----------Receive--------------------------------------Transmit--------5

A locking industrial connector is standard on all CSA/ATEX approved devices. It is also available as an 
option on all other Alicat instruments.

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 - White
4 Remote Tare (Ground to Tare) Green
5 Ground (common for power,

                     communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

Six-pin Industrial Connector
Note: The above pin-out is applicable to all the flow meters and controllers ordered with the industrial 
connector. The availability of different output signals depends on the flow meter options ordered.

Locking Industrial Connector Pin-Outs
If your Alicat Instrument was ordered with a Six Pin Locking Industrial 
connection, please be sure to reference the following pin-out diagram.
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PROFIBUS Pin-Outs
If your Alicat Instrument was ordered with a PROFIBUS connection, 

please be sure to reference the following pin-out diagram.

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE

Power and Signal Connections:
Connect to the device using two DB9 connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and RS-232 or RS-485.
Pin out diagrams for all PROFIBUS enabled Alicat devices are shown below.
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DB15 – Pin-Out Alicat Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8  Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fi xed 5.12Vdc
12 N/C
13 RS-232 RX (receive) or RS-485 –
14 Ground
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certifi cate and user manual for the actual electrical input/output 
requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement when connecting 
a non-Alicat DB15 wire to a DB15 equipped Alicat. Not all features may be available between brands, 
but the common denominators are featured in our DB15 offerings, along with some options for 
customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View

8

15 13 11 9

25
8

1513119

2 5
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DB15B – Pin-Out “Brooks” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fi xed 5.12Vdc
12 N/C
13 N/C
14 RS-232 RX (receive) or RS-485 –
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certifi cate and user manual for the actual electrical input/output 
requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common grounding 
points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement when connecting 
a non-Alicat DB15 wire to a DB15B equipped Alicat. Not all features may be available between 
brands, but the common denominators are featured in our DB15 offerings, along with some options for 
customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

9

5

Male Connector Front View Female Connector Front View

1415

8
8

1514119

2 5

11

2
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DB15K – Pin-Out “MKS” Style

Pin Number Function
1 N/C
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply Common
6 N/C
7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fi xed 5.12Vdc *
10 N/C
11 Ground
12 Ground
13 RS-232 RX (receive) or RS-485 – *
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certifi cate and user manual for the actual electrical input/output 
requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common grounding 
points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

The following pin-out chart describes the safest and generally compatible arrangement when connecting 
a non-Alicat DB15 wire to a DB15K equipped Alicat. Not all features may be available between 
brands, but the common denominators are featured in our DB15 offerings, along with some options for 
customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View

8

13 149

2 5
8

1314 9

25
7

7
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DB15H – Pin-Out “Hastings H” Style

Pin Number Function
1 N/C
2 RS-232 RX (receive) or RS-485 – *
3 N/C
4 N/C
5 Ground
6 Primary Analog Signal Output
7 Power Supply Common
8 N/C
9 N/C
10 Secondary Analog Signal Output / fi xed 5.12Vdc *
11 Power Supply (+Vdc) 
12 Ground
13 N/C

14 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

15 RS-232 TX (send) or RS-485 + *
Check your device’s calibration certifi cate and user manual for the actual electrical input/output 
requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common grounding 
points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

The following pin-out chart describes the safest and generally compatible arrangement when connecting 
a non-Alicat DB15 wire to a DB15H equipped Alicat. Not all features may be available between 
brands, but the common denominators are featured in our DB15 offerings, along with some options for 
customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View

11 151410

2 6

1115 14 10

26
7 7
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DB15S – Pin-Out “Sierra” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output 
3 N/C
4 N/C
5 Ground
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fi xed 5.12Vdc *
12 RS-232 RX (receive) or RS-485 – *
13 Power Supply (+Vdc) 
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certifi cate and user manual for the actual electrical input/output 
requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

The following pin-out chart describes the safest and generally compatible arrangement when connecting 
a non-Alicat DB15 wire to a DB15S equipped Alicat. Not all features may be available between 
brands, but the common denominators are featured in our DB15 offerings, along with some options for 
customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View

11 141312

2

9 1114 13 9

2
8

8

12
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Additional Information for Alicat CSA and ATEX Approved Devices
See the following page for Special Conditions regarding the use of these units!

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 – White
4 Analog Input Signal Green
5 Ground (common for power,

               communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

WARNINGS: 
EXPLOSION HAZARD – DO NOT DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE NON-HAZARDOUS.
EXPLOSION HAZARD – SUBSTITUTION OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

II 3 G

Industrial Connector Overall Clearance
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All Alicat CSA / ATEX approved devices are equipped with a locking 6 pin industrial connector. The 
power and signal connections are shown below.

Clearance Requirements for 
Industrial Connector

Pin# Wire color
1 Red
2 Blue
3 White
4 Green
5 Black
6 Brown

IC-10 Cable

Ø .710

.425

IC-10 Locking Industrial Cable



62

USE of Alicat instruments (M, MC, MS, MCS, MCR, P, PC and PCR product families only) in 
Class 1 Division 2 applications.

CSA certifi es the use of this product for general use as well as use in hazardous locations as 
defi ned by Class 1 Division 2 Group A, B, C and D T4. 
CSA certifi cation is indicated by the product label as shown below and not by the 
statements in this manual or any accompanying documentation.

Special Conditions:
To comply with CSA certifi cation the following information is included in the product literature:

• When equipment is properly labeled, it is suitable in Class I, Division 2, Group A, B, C and D, T4
o Tamb. -40°C to +50°C 

• Electrical Rating 24Vdc, 0.800A max
• Instruments shall be powered by a CSA certifi ed, UL listed, Class II external power supply suitable for 

the application
• Instruments shall be housed in an enclosure with a minimum IP54 rating or location providing equivalent 

protection
• Instrument’s fi nal approval shall be provided by the local authority having jurisdiction

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

X – See manual for special conditions
WARNINGS: 

EXPLOSION HAZARD – DO NOT 
DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE NON-
HAZARDOUS.
EXPLOSION HAZARD – SUBSTITUTION 
OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

www.AlicatScientifi c.com

Alicat Scientifi c, Inc.
Tucson, AZ USA
Tel: 520-290-6060

II 3 G

USE of Alicat instruments (M, MC, MS, MCS, MCR, P, PC and PCR product families only) in 
applications requiring ATEX Certifi cation.
Properly labeled Alicat instruments comply to the following ATEX standard:

II 3 G EEx nA IIC T4 (-40°C ≤ Ta ≤ +50°C)
The examination certifi cate was issued by the CSA in accordance with accepted practices and 
procedures. This confi rms compliance with the European ATEX Directive or Group II Category 
3G equipment.

ATEX certifi cation is indicated by the product label as shown above and not by the statements in this 
manual or any accompanying documentation.
Special Conditions:

• Properly labeled equipment is only certifi ed for use in ambient temperatures in the range of -40°C to 
+50°C only

• Electrical Rating 24Vdc, 0.800A max
• Instruments shall be powered by a CSA certifi ed, UL listed, Class II external power supply suitable for 

the application
• Instruments shall be housed in an enclosure with a minimum IP54 rating or location providing equivalent 

protection
• Instrument’s fi nal approval shall be provided by the local authority having jurisdiction


